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Forord

Oppgaven representerer det avsluttende arbeidet for treårig elektroingeniør utdanning
ved NTNU, og er skrevet av studenter ved studieretningene automasjon & robotikk og
elektronikk & sensorsystemer. Oppgaven er gitt av elektronmikroskopi-laboratoriet ved
institutt for materialteknologi, og er veiledet av institutt for elektroniske systemer. Målet
med rapporten er å gi innsikt i bakgrunn, gjennomføring og resultat av arbeidet som er
utført, og vil fungere som referanse for bruk av det utviklede systemet.

Prosjektet har vært en givende og lærerik erfaring som har gitt stor innsikt i produkt-
utvikling og utøvelse av ingeniøryrket. Det har også vært god erfaring innen gruppe- og
tverrfaglig arbeid. Vi håper resultatet av oppgaven vil være til hjelp for forskningsarbeid
og utdanning ved institutt for materialteknologi, og at resultatet møter oppdragsgivers
forventninger til prosjektet.

Vi vil rette en takk til Mekanisk verksted og Elprolabben ved institutt for elektroniske
systemer for bistand med den praktiske utførelsen av oppgaven. Vi vil også takke veileder
Olav Aleksander Myrvang og oppdragsgiver Jarle Hjelen for godt samarbeid og veiledning
gjennom prosjektet. Til slutt vil vi takke Sergey Khromov og Pål Christian Skaret ved
institutt for materialteknologi for tålmodig bistand og oppfølging av oppgaven.
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Innledning 1

1 Innledning

1.1 Unikt utstyr

Elektron-mikroskopilaboratoriet ved institutt for materialteknologi på NTNU leverer mik-
roskopi tjenester for materialvitenskap, og har syv avanserte elektronmikroskop med opp-
løsning ned til 0.2 mikrometer. Tidlig på 2000-tallet gikk instituttet til innkjøp av spe-
siallaget utstyr for materialkarakterisering i Scanning Electron Microscope (SEM), levert
av en fransk forskningsgruppe. Utstyret består av et strekkbord som monters i vakuum-
kammer, strømforsyning/kontrollenhet, og tilhørende PC-programvare. Hensikten med
strekkbordet er å kunne gjennomføre in-situ undersøkelser av materialer i SEM, og bru-
kes av studenter og forskere ved instituttet blant annet til å undersøke mekanisk styrke
til legeringer. Strekkbordet består av en DC børstemotor som gjennom et drivverk ut-
øver kraft på en materialprøve, en strekklappbasert lastcelle som måler kraften som blir
utøvd, og en LVDT posisjonsgiver som brukes til å måle forlengingen av materialet. Det
som skiller dette strekkbordet fra annet liknende utstyr er at størrelsen gjør det mu-
lig å montere det inne i et vakuumkammer slik at materialprøven kan undersøkes med
elektronmikroskop under strekking for å studere hvordan strukturen i metallet påvirkes
underveis.

Figur 1.1: Strekkbord

Utstyret ble utviklet og patentert [1] i Frankrike på 90-tallet. I patenten er det oppgitt at
motoren er koblet til strekkhodene gjennom to reduksjonsgir med en kombinert girutveks-
ling på 1:3000. Motoren er hastighetsregulert med tilbakekobling gjennom en DC-turteller,
og kan produsere en strekkhastighet på 0.01 - 30 µm/s. Lastcellen er oppgitt til å ha en
nominell lastkapasitet på 10 kN, men kan tillatelig overbelastes til 15 kN. Posisjonsgiveren
er ikke beskrevet i patenten, men det er oppgitt at strekkbordet har et arbeidsområde på
30 mm.
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Innledning 1

1.2 Utstyrets tilstand

Figur 1.2: Kontrollenhet

Styresystemet (kontrollenhet og pc-programvare) har ikke blitt oppdatert siden utstyret
var nytt, og er basert på utdaterte komponenter som er vanskelige å erstatte dersom
det skulle oppstå feil på utstyret. Programvaren kjører på en PC med operativsystemet
Windows 2000, og er basert på en utdatert versjon av LabVIEW som ikke lenger støttes
på moderne operativsystemer. Koblingen mellom kontrollenheten og PC går gjennom et
National Instruments PCI kort, og ettersom at PCI ikke lenger er i bruk på moderne
datamaskiner må det spesialkomponenter til for å overføre systemet dersom det skulle bli
nødvendig. Til kontrollenheten finnes det ingen dokumentasjon, som kretstegninger eller
komponentoversikter, og det vil derfor være svært tidkrevende å utføre vedlikehold eller
reparasjoner på utstyret. Utstyret benytter også spesiallagde D-Sub kabler og kontakter
som er svært skjøre og ofte krever reparasjon.

1.3 Problemstilling

Instituttet har i senere tid blitt bekymret for at strekkbordet skal bli satt ut av drift på
grunn av utstyrets alder og mangel på tilgjengelige reservedeler. Samtidig er ikke tilsva-
rende utstyr lett tilgjengelig på markedet og må derfor spesiallages, noe som kan bli svært
kostbart dersom utstyret skulle erstattes kommersielt. Av den grunn ønsker instituttet å
anskaffe et alternativt kontrollsystem slik at dagens strekkbord kan brukes videre selv
om PC og/eller kontrollenhet skulle svikte. Ny kontrollenhet må ivareta funksjonaliteten
til det eksisterende systemet, men kan med fordel gjennomføres slik at all samhandling
foregår digitalt, og fysiske brytere og display er derfor ikke nødvendig. Utvikling av nytt
kontrollsystem som er kompatibelt med strekkbordet blir vanskeliggjort av mangel på
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Innledning 1

dokumentasjon rundt det eksisterende utstyret, og det må derfor omfattende undersøkel-
ser til for å kartlegge hvordan dagens system fungerer før utvikling av en erstatning kan
iverksettes.

Figur 1.3: Grensesnitt

1.4 Mål for prosjektet

Hensikten med prosjektet beskrevet i denne rapporten er å utvikle elektronikk og pro-
gramvare som kan erstatte det eksisterende styresystemet, og dermed sikre videre bruk
av strekkbordet. Det skal også utarbeides tilstrekkelig dokumentasjon slik at det i fremti-
den vil være enklere å vedlikeholde og/eller videreutvikle systemet. Prosjektets hovedfokus
vil være å etablere grunnleggende funksjonalitet som er nødvendig for strekkprøving, og
eventuelt mer avansert funksjonalitet vil bli vurdert i samråd med oppdragsgiver dersom
tiden tillater det. I lys av oppgavens bakgrunn er det også et mål å benytte størst mulig
grad av åpen kildekode ressursser og godt etablerte standarder for å skape bedre forutset-
ninger for lang levetid for utstyret. ISO standard 6892 [2] omhandler temaet strekkprøving
og vil være veiledende for utviklingen.

1.5 Rapportens oppbygging

Rapporten vil først presentere nødvendig teori for å gi et innblikk i oppgavens bakgrunn
og teknologi benyttet i prosjektet. Deretter vil metodikk for design og implementering bli
gjennomgått, og resultater presentert. Til slutt vil det følge en diskusjon av prosjektets
resultater og gjennomføring, og eventuelle forslag og merknader til videre utvikling.
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Teori 2

2 Teori

2.1 Strekkprøving

Strekkprøving er en metode for å finne bestemte egenskaper til materialer ved å strekke
dem. Metoden går ut på å strekke et material og utføre målinger underveis. Målingene i
dette strekkbordet er av kraften prøven strekkes med, og forlengelsen av prøven. Forlengel-
sen og kraften gir begrenset informasjon da dette er verdier som påvirkes av strekkprøvens
geometri. Men med forlengelsen og kraften, sammen med geometrien, er det mulig å regne
ut spenning(σ) og tøyning(ε). Spenning og tøyning, som ofte også benevnes med de en-
gelske begrepene «stress» og «strain», er fysiske størrelser som kjennetegner egenskaper
til materialet. Kraft og forlengelse i lengde derimot, gjengir bare egenskaper til materialet
i en bestemt form. Spenningen man er ute etter er spenningen midt på strekkprøven.
Denne kan regnes ut med strekkkraften og tversnittet på midten av prøven. Tøyningen
er forlengelsen i forhold til den ubelastede lengden. Formlene for spenning og tøyning er
gitt med:

σ = F

A0
ε = ∆L

L0
(1)

ε

σ

Flytegrense

Strekkfasthet

Brudd

Figur 2.1: Typisk utvikling av et plot for spenning og tøyning
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Figur 2.1 viser hvordan et plott med data på tøyning og stress kan se ut om man strekker
en prøve til brudd. Et plott med data for kraft og forlengelse vil ha samme form og samme
utvikling da variablene er de samme. Den første delen av deformasjonen er det som kalles
elastisk deformasjon, denne er ikke varig. Når metall deformeres elastisk øker tøyningen
proporsjonalt med spenningen. Når trykket blir høyt nok går belastningen over til å
bli plastisk, da er deformasjonen varig. Overgangen fra elastisk til plastisk deformasjon
skjer ved flytegrensen. Men materialet vil enda klare å holde seg sammen til det oppnår
strekkfasthet, dette er det største trykket materialet tåler før det som på engelsk kalles
«necking» inntreffer. Ved «necking» dannes det en innsnevring i prøven hvor bruddet vil
oppstå om prøven fortsetter å bli strukket. Under «necking» vil materialet begynne å
miste styrke til det til slutt dannes et brudd.

Når materialet strekkes er deformasjonen ikke bare i lengden, strekkprøven blir også sma-
lere. Dette gjør at formlene i (1) ikke gjengir den sanne spenningen. Spenningen som form-
lene ovenfor gir kalles på engelsk «engineering strain». For å finne den faktiske spenningen
og tøyningen finnes det formler for sann spenning og tøyning. Disse tar utgangspunkt i
at volumet ikke endrer seg og A0 · L0 = A · L, som er sant under plastisk deformasjon
før «necking». Sann tøyning(εt) baserer tøynings-beregninger på hvor stor forlengelsen er
i forhold til den nåværende lengden som er under konstant endring. «Engineering strain»
bruker startlengden av prøven i beregningene. Endringen i (εt) kan gis ved dεt = dL

L
, dette

kan integreres til εt = ln( L
L0

). Sann spenning(σt) er spenningen beregnet med endring i
tverrsnitt. Sann tøyning kan skrives som σt = F

A
= F

A0
· A0

A
= σ A0

A

L = L0 + ∆L
A0

A
= L

L0
= 1 +

(
∆L

L0

)
σt = σ(1 + ε) εt = ln(1 + ε) (2)
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2.2 Differensialtransformator, LVDT

Linear Variable Differential Transformer (LVDT), er en elektromekanisk sensor som bru-
kes til å konvertere mekanisk posisjon om til elektriske singaler. I systemet benyttes
komponenten til å måle posisjonen eller den lineære forlengelsen til strekkmaterialet.

Strukturen til komponenten er sylindrisk og bestående av en bevegelig kjerne med induk-
tive spoler kveilet i viklinger. Kjernen og spolene har normalt ingen kontakt, som fører
til at komponenten opererer slitasjefritt og har høy reliabilitet over tid. Det skilles mel-
lom en primær- og sekundærspole, der den sekundære er stykket opp av to spoler i serie
(S1 og S2), koblet mellom endeposisjonene, og med motsatt rettet polaritet (U1 og U2).
Primærspolen forsynes av en ekstern AC-kilde på inngangen og produserer en magnetisk
fluks, imens sekundærspolen induserer spenning på utgangen proporsjonalt med endrin-
gen til kjernens posisjon. Når den ferromagnetiske kjernen beveger seg mellom viklingene,
altså når posisjonen endres, induseres spenning avhengig av den magnetiske fluksen rundt
spolene S1 og S2.

Den induserte spenningen over sekundærspolen øker når kjernen beveger seg ut fra midt-
posisjonen, og bevegelsesretningen detekteres av faseendringen som oppstår mellom ende-
punktene. Posisjonen der kjernen befinner seg midt i mellom sekundærspolene er der
Uut = U1 − U2 = 0 og omtales som kjernens nullposisjon. Her vil den magnetiske fluk-
sen virke likt på begge sider av sekundærspolen. Alle andre forskyvninger gjør at enten
U1 > U2 eller U1 < U2, som fører til at spenningen øker på utgangen. Denne spenningen
gir til slutt er uttrykk for posisjonen på utgangen Uut.

Uut = U1 − U2

UutUinn UutUinn UutUinn

Uinn
Uut

Primær Sekundær
S1

U2

UutUinn

U1

S2

Figur 2.2: LVDT karakteristikk
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Ettersom systemet konsekvent fungerer ved bruk av magnetiske flukser, er komponenten
svært sårbar dersom systemet blir utsatt for elektromagnetisk interferens. Magnetfelt fra
eksterne kilder vil virke støyende og kan føre til feilaktige spenningsnivåer på utgangen.
Det kan derfor være viktig å adskille komponenten fysisk eller å montere skjerming med
jordkontakt rundt potensielle støykilder.

2.3 Lastcelle

Lastcelle er en komponent som benyttes til å måle krefter. I strekkbordet benyttes det
en lastcelle til å måle kraften som virker på strekkmaterialet i utstrekningsprosessen. En
vanlig konstruksjon for lastceller er å benytte strekklapper i en Wheatstonebro konfigu-
rasjon.

Strekklapper er motstandskomponenter som varierer i motstandsverdi ettersom kompo-
nenten strekkes eller komprimeres. Komponenten er bestående av en elastisk metalltråd
utstrakt i flere sløyfer som plasseres slik at strekklappen eksponeres for kraften man ønsker
å måle. Ved beregning av motstanden i en strømleder må det tas hensyn til resistiviteten/-
strømledningsevnen til metallet (ρ), i tillegg til lederens tverrsnittareal (A) og lengde (L).
Når metallet strekkes reduseres strømlederens tverrsnittareal og øker metallets lengde.
Som en konsekvens vil motstanden (R) i lederen øke. Det motsatte vil forekomme dersom
strekklappen komprimeres, tverrsnittet øker og lengden reduseres, da vil motstanden i
lederen reduseres.

R = ρ · L

A
(3)

L0

A0

A

L

Nominell

Strukket

Figur 2.3: Dynamikk i strekklapp

En annen viktig faktor å ta i betrakning er at resistansen (R) påvirkes av temperaturen
(T). De vanligste typen strømlederne øker resistansen ved høyere temperaturer, men dette
varierer ut ifra ulike materialer. Temperaturkoeffisienten (α) sier noe om denne sammen-
hengen, der man skiller mellom positive (PTC) og negative temperaturkoeffisienter (NTC)
for ulike materialer. Positive koeffisienter følger den vanligste karakteristikken, altså at
økende temperatur resulterer i økende resistans. Negative koeffisienter vil dermed ha mot-
satt effekt, at økende temperatur gir mindre resistans. Dersom koeffisienten er nære α = 0
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vil temperaturforskjellen (∆T ) ha liten eller ingen påvirkning på resistansen.

R = R0(1 + α∆T ) ∆T = T − T0 (4)

Alle motstander oppgis i en nominell motstandsverdi (R0) og temperatur (T0) ved pro-
duksjon. Det vanligste er at den nominelle motstanden oppgis rundt romtemperatur, altså
ved rundt 20◦C.

Wheatstonebro konfigurasjon brukes ofte i lastceller for å måle kraft. Lastceller benytter
gjerne en, to eller fire strekklapper og fungerer ved at kretsen gjennomgår små endringer i
motstand når systemet utsettes for en endring i kraft. Den minimale endringen motstand
gjør at utgangen opererer i millivolt-området og må derfor ofte kobles opp mot en signal-
forsterker for å få stort nok utslag på utgangssignalet. Konfigurasjonen for strekkbordet
benytter fire motstander, derav to og to er koblet i serie i en parallellforgreining som vist
i figur 2.4.

R1

R3

R2

R4

-     Uut	 +
+

Uinn

-

Figur 2.4: Komplett Wheatstonebro

Ved kretsen er det vanlig å skille mellom to hovedtilstander, altså balansert og ubalansert
tilstand. Balansert tilstand er der Uut = 0 og vil være der strekklappene har motstands-
verdier symmetrisk lik i forgreiningene som i formel (5). Dersom motstandsverdiene ikke
følger denne sammenhengen vil kretsen være i ubalansert tilstand. Dette fører til en spen-
ning på utgangen uttrykt ved (6).

R1

R3
= R2

R4
eller

R3

R1
= R4

R2

R1

R2
= R3

R4
eller

R2

R1
= R4

R3
(5)

Uut = Uut+ − Uut− = Uinn

(
R4

R2 + R4
− R3

R1 + R3

)
(6)

14



Teori 2

Som tidligere nevnt kan lastceller ha noe ulikt oppsett med tanke på antall strekklapper
som benyttes i Wheatstonebroen. De vanligste kombinasjonene er bruk av kvart-, halv-
og komplett målebro, som henholdsvis bruker en, to eller fire strekklapper. En fordel
med bruk av flere strekklapper er at systemet blir enda mer sensitivt og gjør at man
får en større endring i utgangsverdi. Dette er en fordel i systemer hvor det er minimalt
med mekanisk belastning på strekklappene. En annen fordel er at man oppnår tempera-
turkompensering gjennom spenningsdeling, slik at påvirkningen av temperaturforskjeller
minimeres på utgangsverdien.

Dersom vi tar utgangspunkt i en komplett målebro som i figur 2.4, må strekklapp R1 og R4,
samt R2 og R3 plasseres slik at de påføres den samme kraften med hensyn til komprimering
og strekking. Fysisk skal R1 og R4 strekkes samtidig som R2 og R3 komprimeres, men også
omvendt. Dette kan gjøres ved at strekklappene monteres på hver sin side av en rett plate
slik som illustrert i figur 2.5. Siden strekklappene er orientert på hver sin side i forhold
til hverande, blir begge par av strekklappene eksponert for den samme kraftpåvirkningen
(F) når platen bøyes. Dette er avhengig av at kraftpåvirkningen skjer midt i mellom
strekklappene slik at det blir en jevn kraftfordeling over hele planet.

F

R1

R4

F

R2

R3

F

F

Figur 2.5: Strekklappene fysisk montert i forhold til kraftretningen

2.4 Sigma-Delta modulator, ADC

For å lese de analoge utgangssignalene fra sensorene montert på strekkbordet over til et
digitalt format er det nødvendig med en Analog to Digital Converter (ADC). Ettersom
den tiltenkte bruken er i et vitenskaplig instrument stilles det høye krav til presisjon og
nøyaktighet, spesielt med tanke på at det er nødvendig å måle forlengelse i mikrometer-
området over en avstand på opp til én centimeter. Samtidig er kravene til omsetningstid
lave da utstyret har en relativt lav maksimal hastighet.

Ved tasting («sampling») av kontinuerlige signaler til diskrete verdier vil kvantiserings-
støy være uunngåelig, da det fysiske signalet med vilkårlig høy nøyaktighet må tilnærmes
til en verdi av begrenset nøyaktighet. Kvantiseringsstøyen vil ha en amplitude lik halv-
parten av verdien til den minst signifikante bit’en (LSB), og man kan derfor redusere
effekten av kvantiseringsstøyen ved å øke oppløsningen av omformeren. Praktiske hensyn
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som kompleksitet, omformingstid og kostnad setter likevel begrensninger for hvor høy-
oppløselige omformere det er praktisk å bruke, og det er derfor nødvendig med andre
metoder for å redusere effekten av kvantiseringsstøyen. Øking av tastefrekvensen har ikke
noen direkte påvirkning på amplituden eller effekten av kvantiseringsstøyen, men vil øke
støy frekvensen. Dette kan være til nytte da man kan introdusere et lavpass-filter for å
redusere effekten av den høyfrekvente støyen. Denne teknikken kalles støyforming og er
grunnlaget for sigma-delta omformere.

Målesignal Tastet signal Kvantiseringsavvik

Figur 2.6: Lav og høyfrekvent tasting av målesignal

Problemet med å øke tastefrekvensen er igjen kompleksitet, omsetningstid og kostnad. Før
neste tasting kan forekomme må den forrige tastingen være ferdig omsatt og behandlet,
og man er derfor begrenset av databehandlings-kapasiteten for hvor høy tastefrekvens
man kan benytte. En sigma-delta modulator løser dette problemet ved å «overtaste»
og «desimere» målesignalet. Det innebærer at den først omsetter målingen med svært
høy tastefrekvens (overtasting), for så å filtrere ut høyfrekvent støy. Deretter blir det re-
sulterende signalet desimert, dvs. at tastefrekvensen blir redusert til en mer anvendelig
størrelse. Denne prosessen tillater støyforming og filtrering uten å øke kravene til data-
behandlingshastighet. En annen fordel ved denne typen omformer er at den er heldigital,
og dermed resistent mot komponentdrift og temperaturendringer.
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2.5 Qt

Qt er et sett C++ bibliotek og utviklingsverktøy som inkludererer plattformuavhengige
abstraksjoner for grafiske brukergrensesnitt, og brukes til å utvikle applikasjoner som kan
benyttes på ulike plattformer med ingen eller minimal endring i koden. Hovedtrekkene til
Qt er bruken av signaler og spor for å kommunisere mellom objektene. Et signal oppstår
når tilstanden til et objekt forandrer seg, og signalet blir motatt av ett eller flere spor
til ett eller flere objekter. Signaler som er koblet til et spor kan kalle opp sporet når
signalet sendes ut. Qt kan benyttes i andre programmeringsspråk enn C++ gjennom
språkbindinger, for eksempel PyQt for Python.

I Qt benyttes det en rekke grafiske elementer, som for eksempel «widgets». Widgets inklu-
derer blant annet ikoner, rullegardinmenyer, knapper, valgbokser og fremdriftsindikatorer.
I stedet for å skrive kode for å legge ut Widgets kan man bruke et grafisk verktøy slik
som Qt Designer. Programvaren gir enkel «dra og slipp» funksjonalitet for design av
GUI-er. Qt Designer er et Graphical User Interface (GUI) program som kan designe Wi-
dgets, dialogbokser eller lage komplette hovedvinduer ved hjelp av skjemaer. Qt Designer
produserer en «.ui-fil» som er et XML-basert format for lagring av Widgets.

Med bruk av Qt Designer kan man mer effektivt sette opp et grensesnitt enn om man
bruker håndskrevet kode. Men man kan også benytte begge deler i kombinasjon. GUI kan
beskrives som et brukergrensesnitt for et system med interaktive visuelle komponenter
for dataprogramvare. Brukergrensesnittet viser objekter som formidler informasjon, og
representerer handlinger utført av brukeren.
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3 Metodikk

3.1 Komponentvalg og implementering

3.1.1 Signalbehandler, LVDT

Posisjonssensoren som er montert i strekkbordet er i følge utleverte dokumenter (vedlegg
E) en RDP electronics D5/200/327 Linear Variable Differential Transformer (LVDT),
som er kalibrert for en eksitasjonsspenning på 5kHz 5V RMS. For å drive denne kompo-
nenten kreves det signalbehandlings-elektronikk som kan generere eksitasjonsspennnin-
gen, og omforme fase og amplitudeforskjellene i transformatoren til målbar likespenning.
Mange leverandører, inkludert RDP, tilbyr ferdige signalbehandlingskomponenter kali-
brert for sine produkter. Disse produktene er derimot ikke tilgjengelige gjennom offentlige
nettbutikker, og det har ikke lyktes å komme i kontakt med RDP eller leverandører.

Løsningen ble derfor en Analog Devices AD698 Universal Signal conditioner, som kan til-
passes ulike transformatorer og eksitasjonsspenninger. Fordelen med denne løsningen er at
den kan både generere eksitasjonsspenning og omsette posisjonen til et likespenningssig-
nal, og kun krever et nettverk av passive komponenter for å sette eksitasjonsparametere.
Databladet for AD698 [3] inneholder en detaljert steg for steg design prosedyre, som går
ut på å regne ut nødvendige komponentverdier basert på ønsket eksitasjonsspenning og
transformatorens egenskaper. Størrelsene man kommer frem til med likningene i databla-
det er ikke nødvendigvis standard komponentstørrelser, og enkelte passive komponenter
vil derfor være tilnærminger av den optimale størrelsen. Beregning av passive komponen-
ter tilhørende LVDT finnes i vedlegg C.

Utgangssignalet fra signalbehandleren er et likespenningssignal referert mot en spennings-
deler, som i dette tilfellet ligger på 15 volt (halvparten av forsyningsspenning). Denne kan
ikke måles direkte av ADC’en, som måler 0-5 volt. Derfor sendes utgangssignalet først
gjennom en differensiell instrumenteringsforsterker hvor utgangen er referert mot jord,
slik at signalet havner innenfor omformerens måleområde. Utgangsforsterkingen til sig-
nalbehandleren kontrolleres av en motstand, hvor det er montert et trim-potensiometer
for å justere omfanget av utgangssignalet til å bli likt ADC’ens måleomfang.
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3.1.2 ADC

Gitt et måleomfang (m) og en ADC oppløsning i bits (n) kan man beregne en reel oppløs-
ning (r). Med en kjent ønsket oppløsning kan man benytte dette til å beregne nødvendig
ADC oppløsning (n) ved likning 7

r = m

2n − 1 ⇒ n =
⌈
log2

(
1 + m

r

) ⌉
(7)

I dokumentasjon om posisjonsgiveren (Vedlegg E) er det oppgitt et arbeidsområde på ±
5 mm, som gir et måleomfang på 1 cm. Oppløsningen på det originale systemet er ikke
oppgitt noe sted, men den minste størrelsen som er oppgitt i patenten [1] er en minimum
strekkhastighet på 0.01 µm/s, som derfor er valgt som minste ønskede oppløsning. Ved å
sette disse inn i likning 7 får vi et krav om ADC oppløsning på 20 bits. Støy og filtrering
fører til tap av effektiv oppløsning, og det er derfor viktig å skille mellom teoretisk og
effektiv oppløsning. Grunnet det høye kravet til presisjon og det relativt lave kravet til
omformingstid ble 24-bit Delta-Sigma ADC’en Analog Devices AD7714 valgt.

AD7714 trenger kun et eksternt klokkesignal for å fungere, og kommuniserer over SPI pro-
tokoll. Tastefrekvensen er avhengig av knekkfrekvensen for overtastings-filteret (se 3.3.2
for konfigurasjon). Komponenten har flere digitale innganger for å konfigurere kommu-
nikasjon. Klokkepolariteten (POL) er bundet lav for å velge aktiv lav klokke, som må
stemme med konfigurasjonen av mikrokontrolleren. «Buffer» inngangen er bundet lav for
å koble ut bufferet, som kun trenger å brukes under måling ved høy impedans. «Chip-
select» (CS) er bundet lav og «standby» er bundet høy ettersom at ADC’en alltid skal
være aktiv. «Reset» inngangen er koblet til en digital utgang på mikrokontrolleren slik at
ADC’en kan tilbakestilles under drift om det skulle bli nødvendig. Detaljert beskrivelse
av digital konfigurasjon ved normal drift finnes i seksjon 3.3.2.

3.1.3 Instrumenteringsforsterker – Lastcelle & LVDT

Instrumenteringsforsterkeren Texas Instruments INA126P benyttes to ganger i kretsen,
der en benyttes som differensiell instrumenteringsforsterker mellom LVDT og ADC, imens
den andre benyttes som differensiell forsterker hos lastcellens utgangssignal. Førstnevnte
kan leses mer om i seksjon 3.1.1 om signalbehandler, LVDT.

Ved normale variasjoner av kraft på lastcellen vil utgangsspenningen fra målebroen utgjø-
re relativt små variasjoner. For å kunne gjøre hele måleområdet fra kraftmålingene om til
avlesbare målespenninger for ADC ble det derfor nødvendig å implementere instrument-
forsterker for å forsterke signalet.
Siden målebroens signalvariasjoner opererer rundt millivolt vil den være mer sårbar for
eksterne støykilder. Det er derfor viktig at instrumentforsterkeren har gode egenskaper
som tilfredsstilles for bruk i slike applikasjoner.
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Figur 3.1: Oppkobling av lastcelle

Beregning av utgangsspenning fra instrumentforsterkeren:

Uut =
(
Usig

− − Usig
+
)

·
(

5 + 80kΩ
RG

)
+ Uref (8)

Kombinert fullstendig med lastcellens målebro (6):

Uut = Uinn ·
(

R3

R1 + R3
− R4

R2 + R4

)
·
(

5 + 80kΩ
RG

)
+ Uref (9)

3.1.4 Motorkontroller

I det originale kontrollsystemet brukes en Maxon Motor Lineær Servo kontroller til å
regulere strekkhastigheten. Denne kontrolleren er gått ut av produksjon, men i sin pro-
duktkatalog [4] anbefaler produsenten en nyere kontroller av typen ESCON 36/2 DC.
På grunn av pågående komponentmangel etter koronapandemien var det ikke mulig å
anskaffe denne kontrolleren gjennom offentlige nettbutikker, men etter å ha tatt kontakt
med Maxon kunne én enhet leveres gjennom datterselskapet DJ Stork Drives AS.

Motorkontrolleren er koblet til mikrokontrolleren gjennom to digitale og en pulsbredde-
modulert (PWM) datalinje, hvor de to digitale inngangene brukes til å starte motoren og
velge dreieretning. Hastigheten settes over PWM linjen. Kontrolleren regulerer motorhas-
tigheten med tilbakekobling fra en DC-turteller montert på motorakslingen, konfigurasjon
og kalibrering av reguleringen er beskrevet i 3.4.3.
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3.1.5 Mikrokontroller

ISO standarden for strekkprøving [2] inneholder et vedlegg om konstruksjon av måleut-
styr, hvor det anbefales at utstyret ikke foretar noen databehandling, men sender råverdier
videre til en PC for behandling. Av den grunn er kravene til databehandlingshastighet i
mikrokontrolleren lave, da den kun skal fungere som et mellomledd i kommunikasjon mel-
lom PC, ADC og motorkontroller. For å kommunisere med disse komponentene må mikro-
kontrolleren ha støtte for protokollene SPI og UART, og pulsbreddemodulering (PWM).
Motorkontrolleren har en PWM oppløsning på 12 bit, og mikrokontrolleren må derfor
støtte minst samme oppløsning for å regulere motorhastigheten så presist som mulig. Det
gamle systemet kunne ikke enkelt overføres til en nyere datamaskin på grunn av det pro-
prietære PCI kortet som hånderte kommunikasjon. Derfor ble det også satt som et krav
at mikrokontrolleren kunne kobles opp mot PC gjennom standard USB for mest mulig
fleksibilitet.

De fleste moderne mikrokontrollere har støtte for de nevnte protokollene, og valget ble
derfor basert på tidligere erfaring med programmering. Microchip Atmega4809 Curiosity
Nano er et evalueringssett for Atmega4809 kontrolleren, og møter alle krav til funksjo-
nalitet for prosjektet. Kontrolleren har flere utganger og høyere oppløsning enn det som
er nødvendig, men ettersom at det kun skal produseres én enhet blir kostnadsforskjellen
neglisjerbar og utviklingstiden ble heller prioritert.

3.1.6 Strømforsyning

Systemets strømforsyning er en åpen AC-DC transformator som gir ut 30VDC og inntil
1.34A (40W). Med en slik løsning vil 230VAC spenningen termineres på innsiden av
instrumentboksen mot hovedbryteren. En fordel med denne strømforsyningen er at den
har støtte for to utgangsterminaler, som gjør at man kan skille strømforsyningen mellom
motorkontrolleren og kretskortet.

I forbindelse med strømforsyning benytter systemet flere sikringer. Det finnes en over-
ordnet til hele forsyningen av systemet (F1) og en egen til forsyningen av kretskortet
(F3). Kretskortsikringen plasseres inne i sikringsokkelen plassert inne i boksen, imens sys-
temsikringen er plassert inne i instrumentboksens strømkontakt. Nærmere illustrasjon ser
man i figur 3.2

Strømforsyningen (PSU) har i seg selv innebygde sikringer (F2) på 230V-siden for hver av
inngangsterminalene på 2A. Dette vil si at en sikring (F1) i strømkontakten som er satt
til 1A vil ha en lavere terskelverdi og vil derfor ryke før sikringene på strømforsyningen.
Dette er gunstig fordi strømkontaktens glass-sikring vil være langt lettere å bytte ut enn
de som er loddet direkte på strømforsyningen.
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(a) Fysisk sikringsoppsett

230V ~

F1

PSU

PCBF3

Escon MC

30
VF2

(b) Enlinjeskjema med sikringer

Figur 3.2: Instrumentboksens sikringer

Kretskortets design krever at den tåler strømtrekket fra de ulike kretskomponentene.
Banetykkelse i Altium ble satt til 0.254mm som er beregnet til å kunne belastes med et
maksimalt strømtrekk på 1.215A (fra tabell: 3.1), noe som forventes å være innenfor god
margin til komponentene som ble benyttet i kretsen. Faktorene som er tatt i betraktning
er lagtykkelsen, banelengden, kortets tiltatte temperaturøkning (ved strømtilførsel) og
omgivelsestemperaturen til systemet.

Beregningen er gjort gjennom selskapet Digi-key’s forhåndsdefinerte kalkulator [5] og er
basert på IPC-2221 som er en generisk standard for PCB design.

Parameter Enhet
Banetykkelse 0.254 mm

Tykkelse 0.03556 mm
Temp. Økning 20 ◦C

Temp. omgivelse 22 ◦C
Banelengde 160 mm
Resultat Enhet

Maksimalt strømtrekk 1.215 A
Banemotstand 8.16 Ω
Spenningsfall 9.9 V

Energitap 12.04 W

Tabell 3.1: Beregning av banetykkelse for kretskort

Kalkulatoren estimerer at det maksimale strømtrekket ligger rundt 1.215 A. Verdiene går
ut ifra at strømlederne ligger mot en ytre overflate og eksponeres for luft, noe som gjør at
strømtrekket kan være langt mer enn hvis strømbanene hadde vært tildekket. I luft har
de ytre lagene større varmeoverføring som følge av konveksjon og gjør at kretsen kvitter
seg ved varme mer effektivt.
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Sikringen til forsyningen av kretskortet (F3) ble etter beregningene satt til 1A for å sikre
strømbanene på kretskortet for overbelastninger. Det ble avslutningsvis gjennomført en
kontrollmåling av total strømtrekk til kretskort på rundt 40mA under normal drift. Dette
betyr at kretskortet under normale omstendigheter er langt unna sikringsstørrelsen.

Motorkontrolleren vil være tilkoblet direkte mot kretskortet uten eksterne tilpassede sik-
ringer. Maksimalt nominelt strømtrekk fra motoren vil være 0.592A i følge datablad [4]
og man ser at man vil kunne benytte lik banetykkelse for hele kretskortet. Tykkelsen for
motoren ble satt opp til 0.5mm for å legge til ekstra margin dersom motoren over tid
begynner å trekke mer strøm.

3.2 Kretskortdesign og innhusing

3.2.1 Altium

Som en del av oppgaven inngår implementering av styreelektronikk som tilpasses til en
instrumentboks. Elektronikken ble først testet med en provisorisk løsning for å funksjons-
teste kretselektronikken, før den senere ble implementert på et kretskort. Siden kretsen
består av både digitale- og analoge signaler ble det gjort enkelte tiltak for å forhindre for-
styrrelser mellom signaler. Digitale signalerkretser bruker binær logikk som ofte vil kunne
tolerere mer støyinterferens i motsetning til analoge kretser. Siden analoge signaler fra
strekkbordet danner grunnlaget for analyse av strekkprøven ble det viktig å minimalisere
selvprodusert støygenerering internt på kretskortet for å oppnå presise måledata.

Kretskortdesign blir ofte beskrevet slik at det ikke finnes en bestemt metode for design.
Det vil ofte innbære «prøve & feile metode», men det finnes grunnleggende regler som skal
kunne minimere sannsynligheten for et dårlig design. Design av kretskortet ble gjort med
inspirasjon fra anbefalingene beskrevet i en artikkel fra Altium om generelle prinsipper
for oppsett av kretskort[6].

Det antas at motorkontrolleren vil potensielt være kilde til støygenerering på kretskor-
tet ettersom motorkablene er skjermet fra leverandør. For å opprettholde skjermingens
funksjonalitet ble den terminert med kort avstand til skruterminalen på kretskortet. Plas-
seringen på skrueterminalene tilhørende motorkontrolleren ble i tillegg satt i nærhet av
D-sub konnektor med formål om å holde banene adskilt fra resten av elektronikken og
minimere den totale banelengden på kretskortet.
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Kretsen benytter totalt tre ulike spenningsnivå i tillegg til flere kretskomponenter som
krever ulike forsyningspenning. Disse ble forsøkt holdt innenfor egne soner for å enklere
gruppere de ulike komponentene på kretskortet som vist i figur 3.3. Med dette ble det
også oppnådd minimalt antall kryssinger mellom de to planene.

Figur 3.3: Komponentinndeling

Fysisk dimensjonering av kretskortet ble bestemt samtidig som valg av instrumentboks.
Målene på kortet ble fastsatt med marginer fra dimensjonsmålene til instrumentboksen
som ga muligheten til eventuelle endringer av plassering av komponenter dersom det skulle
oppstå endringer. Siden valgt instrumentboks var relativt stor i forhold til kretsen ble også
kortet dimensjonert med ekstra størrelse for å gi muligheten til å holde kretskomponentene
fysisk adskilt. Dette vil i tillegg til å være et støyreduserende tiltak også legge til rette
muligheter for eventuelle endringer av kretskortet som krever flere kretskomponenter for
videreutvikling.

Man ser fra figur 3.3 at D-sub og mikrokontrollerens tilkoblingspunkter ble posisjonert på
kretskortet slik at de ble montert «flush» mot frontpanelet til instrumentboksen. Dette
ble gjort for å forenkle oppkobling av strekkbordet og PC til styreelektronikken.

Fra figur 3.4 vil man kunne se tydelig grunnlaget for plasseringen til både spenning- og
motorterminering til kretskortet. Med dette ble forsyningskabel til kretskortet lagt med
god avstand til motorkontrolleren.
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3.2.2 Innhusing

Instrumentboksen er bestilt som en standardkomponent med faste dimensjoner og er
derfor ikke fullstendig spesialtilpasset med hensyn på elektronikkens størrelse. Valget av
instrumentboks ble gjort gjennom å ta hensyn til de største komponentene og kretskortes
antatte dimensjoner. I planleggingsfasen ble det benyttet enkle skisser for boksinndelingen
og essensielle mål fra datablader ble implementert. Et viktig prinsipp ble å bestille en
boks som er noe større enn estimatene for å sikre stor nok plass for koblingspunkter og
for å forhindre varmeutvikling og magnetisk interferens mellom komponentene. Når det
kommer til instrumentboksens materialkvalitet var ønsket å benytte noe som er slitesterkt,
men samtidig anvendelig for utskjæring. Valget falt til slutt på en instrumentboks med
stålramme og tilhørende aluminium front- og bakdeksel.

Inndelingen av seksjoner i instrumentboksen gikk hovedsakelig ut på å skille mellom støy-
ende komponenter og mer følsom elektronikk. I den sammenheng ble det spesiallaget en
adskillelsesvegg som strekker seg over den stiplede midtlinjen i figur 3.4 ved instrument-
boksens oppsett, og har som funksjon å skjerme støyende komponenter som strømforsy-
ningen (PSU) og motorkontrolleren (MC) fra resten av systemet. For montering av de
ulike komponentene måtte det også skjæres ut en monteringsplate som omtrent tilsvarer
boksens grunnflateareal. Begge plater er konstruert av aluminium og ble spesialtilpasset
instrumentboksen, disse illustreres under skissen av oppsettet for boksen.
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Figur 3.4: Instumentboksens oppsett, monteringsplate og skjerming
(Dimensjon: mm)
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3.2.3 Kabeloppsett & Koblingsskjema

Dokumentasjonen hos det tidligere kabeloppsettet opplevdes som forvirrende og tidskre-
vende å bruke, samtidig som termineringen til strekkbordet ikke benyttet standardnota-
sjon. En del av dokumenteringen har derfor gått med på å fornye denne informasjonen
og er vedlagt i vedlegg B. Vedlegget illustrerer hele kabeloppsettet fra «traction port» på
instrumentboksen til mikro D-sub på strekkbordet og følger standardnotasjon for termi-
nering av koblinger.

Ved overtakelse av systemet ble det informert om at enkelte av de opprinnelige kablene
hadde brudd og det har vært et vedvarende problem der kabler må loddes på nytt. Noe av
grunnen til problematikken rundt kablene kan skyldes at systemet benytter svært tynne
kabler for å passe mikro D-sub samtidig som systemets brukerkarakteristikk har preg av
at man ofte plugger ut og inn. Til tross for dette ble det valgt å videreføre samme type
koblingsoppsett, siden den spesialiserte strekkbenkmodulen allerede benytter mikro D-sub
og for at det gamle styresystemet fremdeles skulle være kompatibelt. Kablene med brudd
ble derfor innlevert til reparasjon med tilsvarende dokumentasjon som hos det gamle.

Vedlegg A viser oversikt over koblingsskjemaet til kretsen. Denne fremstiller koblingene
som er gjort på PCB kortet mellom alle valgte komponenter. På denne måten kan man
tyde sammenhengen mellom de ulike komponentene i kretsen.

3.3 Mikrokontroller programmering

Mikrokontrollerens kode kan finnes på GitHub:

GitHub/NTNU-E2227/TensileTester_MCU

3.3.1 UART

Kommunikasjonen mellom mikrokontrolleren og PC går gjennom en virtuell serieport over
UART protokoll. I mikrokontrolleren er mottak av data håndtert av en avbruddsrutine
(ISR) som kalles opp når én byte (8-bit) er mottatt fra PC. Mottatt data blir tolket
som ASCII karakterer og plasseres i et buffer frem til siste mottatte byte er et linjeskift
(0x0A). Etter linjeskiftet blir bufferet tolket som en kommando, hvor første mottatte byte
representerer kommandoen og etterfølgende to bytes representerer motorhastighet. Imple-
menterte kommandoer er ’s’ (stop), ’l’ (load), ’u’ (unload), og ’r’ (reset). Load og unload
starter motoren i hver sin retning, og krever motorhastighet som en del av kommandoen.
Hastigheten er kodet som et heksadesimal-tall med fire siffer (se 3.3.3). Stop skrur av
motoren og reset tilbakestiller og initialiserer ADC’en (se 3.3.2).

Utgående data sendes som to ASCII kodede heksadesimale tall med seks siffer, og etter-
følges av et linjeskift. Avlesning av ADC fra kanal 1 sendes først, deretter kanal 2. Opp-
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rinnelig var utgående data ikke ASCII enkodet, men sendt direkte som tallverdier. Dette
førte innimellom til synkroniseringsproblemer hvis en byte ikke ble motatt korrekt, og det
ble derfor besluttet å legge inn et synkroniseringssignal mellom hver datapakke for stabil
kommunikasjon. Ettersom sending av rådata i bytes uten enkoding tar opp alle tilgjenge-
lige verdier, ble råverdiene kodet til ASCII og linjeskift brukt som synkroniserginssignal.
Denne enkodingen halverer informasjonstettheten i datapakkene ettersom at det tar en
8-bit ASCII karakter til å representere et heksadesimalt siffer, som tilsvarer 4 bits av
råverdien. Datahastigheten er allikevel rask nok til at denne reduksjonen i effektivitet er
neglisjerbar.

Register Konfigurasjon
BAUDH 0x02
BAUDL 0xB6
CTRLA 0x80
CTRLB 0xC0
CTRLC 0x0B

Tabell 3.2: Registerkonfigurasjon, Atmega4809, UART

Konfigurasjon av registere for UART er satt ut fra databladet for Atmega4809 [7] for asyn-
kron kommunikasjon med både sender og mottaker aktivert. Det benyttes 8-bit pakkestør-
relse uten paritetsbit, og med to stopp-bits. Avbruddsflagget for mottak fullført er aktivert.
Overføringshastigheten gitt i symboler per sekund (baud), er satt til 115200 da dette er
den høyeste hastigheten med bred støtte fra de fleste operativsystemer. Konfigurasjonen
av denne hastigheten regnes ut fra likning 10 gitt i databladet:

fBAUD = 64 · fclk_per

S · BAUD
= 64 · 20 · 106

16 · 115200 ≈ 694(0x02B6) (10)

3.3.2 SPI

Kommunikasjon med ADC (AD7714) foregår over SPI protokoll, hvor mikrokontrolleren
er hovedenhet («main») og ADC’en er underenhet («subnode»). Hovedenheten genererer
klokkesignalet som regulerer kommunikasjonen, og data sendes i full toveiskommunika-
sjon («duplex») over datalinjene markert MOSI (Main Out Subnode In) og MISO (Main
In Subnode Out). Kommunikasjonen starter med en forespørsel fra mikrokontroller til
ADC om avlesing av en omformingskanal som starter omformingen av målesignalet. Når
omformingen er fullført signaliserer ADC’en at ny data er tilgjengelig ved å sette Data
Ready linjen (DRDY) lav, som får mikrokontrolleren til å starte klokken (SCLK) for å
motta dataen. Når overføringen er fullført sender mikrokontrolleren en ny dataforespørsel
til neste kanal, og veksler mellom kanalene for kraft- og posisjonsgiver.

SPI kommunikasjonen er konfigurert slik at den mest signifikante biten (MSB) sendes
først, og den minst signifikante biten (LSB) sendes sist. Tasting av bitverdier er satt til
stigende flanke på klokkesignalet, som er én 128. del av prosessorhastigheten til mikrokon-
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Register Konfigurasjon
CTRLA 0x27
CTRLB 0xC7

Tabell 3.3: Registerkonfigurasjon, Atmega4809, SPI

trolleren. Før normal toveiskommunikasjon begynner, kjører mikrokontrolleren en initia-
liseringsrutine på ADCen. Først blir «reset-linjen» inn til ADC satt lav i ti millisekunder
for å tilbakestille enheten. Deretter blir den konfigurert for 24-bit dataord og filtrering
med 50 Hz knekkfrekvens. Til slutt blir ADCen’s innebygde selvkalibreringsrutine kjørt.
Denne initialiseringsrutinen kan når som helst kalles opp over UART ved kommandoen
’r’ (reset).

x3

MSB (1)

DRDY

SCLK

24-bit (3x8-bit) dataord, ADC avlesning
MISO
LSB (3)

MOSI

0 = Kanal 1, 1 = Kanal 2

Data-forespørsel, ADC kanal

Figur 3.5: SPI timing diagram

3.3.3 PWM

Motorhastigheten settes med et pulsbreddemodulert (PWM) signal fra mikrokontroller
til motorkontroller. PWM signalet genereres med et 16-bit telleregister (TCA) som inkre-
menteres for hver klokkesyklus i mikrokontrolleren. Telleregisteret sammenliknes med et
perioderegister (PERBUF) og tilbakestilles når TCA > PERBUF . Utgangssignalet ge-
nereres av et sammenlikningsregister (CMPBUF), hvor utgangssignalet er i arbeidssyklus
når TCA < CMPBUF .
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TCA

PERBUF

CMPBUF

PWM signal

Periode

Arbeidssyklus

Figur 3.6: PWM timing diagram

Verdien av sammenlikningsregisteret er begrenset av verdien på perioderegisteret, og om
man øker periodetiden blir derfor også oppløsningen større ved å øke antallet mulige
verdier for sammenlikningsregisteret. Signaler med lengre periodetid er også enklere å
nøyaktig omforme tilbake til digital verdi for motorkontrolleren. Frekvensen for PWM
signalet er derfor satt til 10 Hz som er laveste tilatelige verdi gitt i databladet for motor-
kontrolleren [8]. Det er også oppgitt at motorkontrolleren opererer med arbeidssyklus på
10-90%. Sammenlikningsregisteret justeres under drift med UART kommandoene ’l’(load)
og ’u’(unload), hvor motorhastighets argumentet plasseres direkte inn i sammenliknings-
registeret. For å beregne den nødvendige verdien av sammenlikningsregisteret for en gitt
motorhastighet benyttes likning 11.

CMPBUF (Mspeed) =

(Mspeed − Mmin) · 0.8 · PERBUF

Mmax − Mmin

+ 0.1 · PERBUF

 (11)

Register Konfigurasjon
CTRLA 0x0B
CTRLB 0x13

EVCTRL 0x00
PERBUFH 0x75
PERBUFL 0x30

Tabell 3.4: Registerkonfigurasjon, Atmega4809, PWM
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3.4 Kalibrering

Kalibrering er essensielt for å kunne gjøre riktige avlesninger av et målesystem. Prosedy-
ren for kalibrering vil ta utgangspunkt fra lignende målesystemer som benyttes til kraft
og posisjonsmåling. Målingene ble sammenlignet og funksjonskoeffisienter som benyttes
til rådatabehandling ble beregnet ut fra minste kvadraters metode som beskrevet i doku-
mentasjon fra MathWorks [9].
Behandling av rådataverdier for både lastcellen og posisjonssensoren vil kunne bruke opp-
til et fjerdegradspolynom:

Posisjon(x) =
4∑

n=0
Dn · xn [µm] (12)

Kraft(x) =
4∑

n=0
Si,n · xn [N ] (13)

(i = strength range konfigurasjon)

For å kunne gjøre direkte avlesninger av rådataverdier fra ADC ble førstegrads-koeffisientene
i config.txt satt til en, og resten satt til null.

3.4.1 Lastcelle

Kraftmålingen fra lastcellen benyttes til direkte avlesning og for beregning av stress.
For å kunne gjøre presise målinger ble det implementert to trimpotensiometer på krets-
kortet som skal kunne gi muligheten til å kalibrere lastcellen. På grunn av lastcellens
konfigurasjon vil målebroen være i balanse når cellen står uten kraftpåvirkning, og målt
differansespenning i målebroen vil være null. Målebroen er koblet til forsterkeren slik
at det blir et negativt forhold mellom kraften og utgangsspenningen. Ved referansen for
instrumenteringsforsterkeren ble det montert et trimpotensiometer for å justere inn ut-
gangsspenningen til 5V ved 0N.

Sette måleområde:

Med 10kPot(2) fra koblingsskjema (vedlegg A) vil man ha muligheten til å sette en refe-
ransespenning på utgangen til instrumentforsterkeren til å være mellom:

Urefmax = 10V ·
(

47KΩ
94KΩ + 0KΩ

)
= 5V (14)

Urefmin = 10V ·
(

47KΩ
94KΩ + 10KΩ

)
= 4.52V (15)
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5V

0V
0N 3kN


10kPot(2) 1kPot

4.52V
4.75V

5V

0V
0N 3kN


4.75V

Figur 3.7: Illustrasjon av justering for lastcelle

Siden lastcellen ble koblet til å bidra negativt på utgangssignalet ved økende kraftpåvirk-
ning ble referansespenningen til instrumentforsterkeren justert frem til avlest rådata nådde
sin høyeste verdi (≈ 5V ) når målebroen var i balanse. Potensiometer- og referansespen-
ningens endelige innstilling ble satt litt tilbake for å forsikre et fullstendig måleområde.

10kPot(2) ble satt til 4.87kΩ som gir en referansespenning:

Uref =
(

47kΩ
2 · 47kΩ + 4.87kΩ

)
· 10V = 4.754V (16)

1kPot gir muligheten for å sette forsterkningen til instrumentforsterkeren. For innjustering
av motstandsverdi ble lastcellen utsatt for maksimal kraftpåvirkning i S1-konfigurasjon
(3KN). Potensiometeret ble justert frem til avlest rådata nådde sin minimale verdi (≈
0V ) ved 3KN. Endelig motstandsverdi ble justert tilbake for å forsikre et fullstendig
måleområde.

1kPot ble satt til 500Ω som gir en forsterkning:

Forsterkning = 5 + 80kΩ
500Ω = 165 (17)

Fra instrumenteringsforsterkerens datablad [10] og innstilt forsterkning vil man kunne
finne hvilket direkte spenningsområdet målebroen vil ha under normal drift dersom mot-
standen Rg = 500Ω. Maksimale spenningsvariasjoner direkte fra målebroen:

∆U ≈ 5V

5 + 80kΩ
RG

= 30mV (18)
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Logging og kalibrering:
Lastcellen ble demontert fra strekkbordet og satt inn i en maskin som kunne utføre må-
linger av både strekking og kompresjon. Sammenlikning mellom maskinens kraftavlesning
og rådata ble logget ved ulike kraftpåvirkninger.

(a) Kalibrering (b) Lastcellens konfigurasjon

Figur 3.8: Kalibrering av lastcelle

Etter kalibreringen ble det observert måleverdier med omfattende avvik. Det ble derfor
bestemt å gjennomføre en lik kalibreringsprosedyre mot det eldre styresystemet. Metoden
tar målinger fra eldre systemet for ulik påvirkning av kraft, før strekkbordet kobles over
til ny styreelektronikk og tilsvarende rådata logges.
Regresjonsanalyse av datapunktene fra lastcellen viste seg å være relativt lineære over
måleområdet, og det ble besluttet å benytte førsteordensfunksjon for rådatabehandling.

Lastcellen har tre ulike innstillinger som benyttes for konfigurasjon av maksimal måle-
grense på henholdsvis 3KN, 5KN og 10KN. Siden de ulike konfigurasjonene vil endre
trykkpunktene på lastcellen (figur 3.8(b)) vil de også kunne påvirke karakteristikken til
målingene. Det ble derfor gjennomført lik kalibreringsmetode for alle konfigurasjonene.

3.4.2 LVDT

Posisjonssensorens målinger vil benyttes for både direkte avlesning og beregning i relativ
forlengelse som benyttes i grafen. For å oppnå presise posisjonmålinger ble det imple-
mentert et potensiometer som skal kunne gjøre det mulig å kalibrere signalområdet for
signalkretsen til LVDT. Signalkretsens spenningssignal ble kalibrerert for maksimal dif-
feranse på én volt ved fullstendig mekanisk måleområde til sensoren. Signalet er videre
koblet til en instrumenteringsforsterker som forsterker signalet(Forsterkning = 5) for å
få fullstendig måleområdet på fem volt til ADC. Innjustering av fullstendig måleområdet
ble gjort ved å sette strekkbordet i endeposisjon samtidig som potensiometeret ble justert
til ADC’en målte sin maksimale rådataverdi.
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Figur 3.9: Kalibrering av posisjonssensor

Kalibrering av posisjonssensoren ble gjennomført mot målinger fra et referansemålesystem
som vist i figur 3.9. Et optisk måleinstrument ble benyttet som referanse for målingene
av posisjon. Funksjonskoeffisientene for rådatabehandling ble beregnet ut fra regresjon av
målte datapunkter med posisjon- og rådataverdier.

3.4.3 Motorkontroller

Motoren drives av ESCON 36/2 DC servokontroller som har flere muligheter for opp-
sett av både regulering og styring. For kalibrering av motorkontrolleren benyttes ESCON
Studio som er et tilhørende programvare for oppsett av motorkontrollerens funksjona-
litet. Gjennom en oppstartguide ble analoge og digitale porter konfigurert etter ønsket
funksjon. I tillegg ble reguleringsprinsippet satt opp i «closed-loop» konfigurasjon mot
omdreiningshastigheten målt fra tachometeret som er mekanisk festet til motoraksling.

Motorkontroller Motor Gir

Tachometer

Settpunkt Strekkhastighet

Figur 3.10: Reguleringsstruktur

For å oppnå ønsket settpunkt har motorkontrolleren muligheter til å sette regulatorpara-
metre manuelt eller automatisk ved «autotuning». For å oppnå nøyaktighet var det viktig
å stille inn riktige parametre for at motorhastigheten skal kunne reguleres med små avvik
og med raskt innsvingningsforløp. Det ble derfor gjennomført «autotuning» og man kan
se fra figur (3.11) at reguleringen ble optimalisert. Sammenlikning på grafene viser at
innsvingningsresponsen reagerer raskt med minimalt oversving.
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Figur 3.11: Autotuning motorkontroller (ESCON Studio)

Styrekretsen tar utgangspunkt fra tidligere system der man har muligheten til å velge vel-
ge hastighet. Siden tachometeret allerede var montert på strekkbordet ble den brukt i det
nye systemet for beregning av hastigheten på strekkingen. Denne tar utgangspunkt i et
proposjonalt forhold mellom omdreiningshastigheten og strekkhastigheten. Kalibreringen
ble gjennomført ved å måle tidsdifferansen mellom to posisjoner med en fast omdreinings-
hastighet. Siden motorkontrolleren er innstilt med en rampetid måtte kalibreringene skje
etter motoren hadde stabilisert rundt referansehastigheten.

3.5 Brukergrensesnitt

Koden for grensesnittet ligger tilgjengelig på GitHub:

GitHub/NTNU-E2227/TensileTester

Oppdragsgiver hadde ingen føringer for hvilket program som skulle benyttes for å lage
brukergrensesnittet. Gruppen sto dermed fritt til å velge hvilken platform som skulle
benyttes.

I oppstartsfasen av prosjektet sto valget mellom Python (PyQt) og LabVIEW. På det tid-
ligere systemet ble LabVIEW benyttet som plattform for utvikling av brukergrensesnittet.
LabVIEW er et utviklingsmiljø fra National Instruments som benyttes for industrielle tes-
ter, måle- og automatiseringsapplikasjoner. Til tross for programmets allsidighet ble det
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tidlig bestemt å benytte Python for utvikling av grensesnittet hos det nye systemet. Pyt-
hon er basert på åpenkildekode med mange muligheter for å lage et moderne grensesnitt
som vil være enklere å videreutvikle i fremtiden. I tillegg har Python en stor brukerbase
med mange tilgjengelige ressurser og er kompatibelt med GitHub som samarbeidsportal.
På denne måten fikk man større oversikt og det ble lettere å jobbe sammen om program-
meringen.

I forbindelse med PyQt biblioteket er Qt-designer benyttet som et hjelpemiddel for pro-
duksjonen av brukergrensesnittet. Programmet er et grafisk verktøy som gir muligheten
til å plassere interaktive knapper, tekstbokser og andre elementer i et programvindu. Pro-
grammet vil generere en Qt-designer fil (.ui) som konverteres gjennom terminalvinduet
for å bli oversatt til Python kode (.py). Denne filen blir fungerende som et stiloppsett for
programmet og definerer brukergrensesnittets oppsett og utseende. På denne måten vil
produksjonen og eventuelle endringer av grensesnittet være tidsbesparende i forhold til å
implementere programkoden manuelt.

For å konvertere filtypen fra Qt-Designer(.ui) til Python(.py) ble kommandoen nedenfor
benyttet:

1 \ designerfiles > pyuic5 -x < DesignerFile >.ui -o < DesignerFile >.py

3.5.1 Design & funksjonalitet

Figur 3.12: Grensesnitt

Det ble tidlig tatt en avgjørelse om å utvikle et brukergrensesnitt med nøytral fargebruk.
Valget av farge falt på en mørk grå fargetone som er behagelig å se på over tid. Dette
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er viktig da brukeren benytter grensesnittet over en lengre periode. Selve bestemmelsen
av funksjonalitet ble gjort i stor grad gjennom samtale med oppdragsgiver og veiledere
for å sikre et tilstrekkelig antall funksjoner som dekker bruksomfanget til strekkbordet.
Knappene ble plassert på venstre side av brukergrensesnittet for å oppnå en god flyt
og overgang mot grafene på høyere side. Ett viktig prinsipp var å forsøke å holde bru-
kergrensesnittet oversiktlig og ikke implementere flere grafiske elementer enn absolutt
nødvendig på en side. Det ble derfor valgt å kun holde funksjonene som er direkte relatert
til driften av strekkbordet på brukergrensesnittets hovedside (se figur: 3.12).

På enkelte av brukergrensesnittets knapper er det satt kontinuerlig blå farge for å indikere
om tilstanden er aktivert eller ikke. Dette gjelder Data logging, men også parvis mellom
Start/Stop og Tensile/Release funksjonene. En årsak til at blått ble valgt er at enkelte
andre farger ofte kan forbindes med forskjellige lysindikasjoner. For eksempel er rødt ofte
forbundet med fare, imens grønt fungerer som klarsignal. Slik fargebruk er bevisst unngått
for å unngå missvisende signaler ovenfor brukeren.

Tidligere system benyttet to hovedvinduer for innstillingsparametre og kontrollering av
strekkbordet. For det nye grensesnittet ble det bestemt å benytte dialogvindu i større
grad for å oppnå lik funksjonalitet som fra tidligere system i tillegg til at man oppnår
et oversiktlig brukergrensesnitt. Under "Tools → Geometry" vil man få frem dialogvindu
(3.13) der man kan tallfeste mekaniske dimensjonsverdiene for strekkmaterialprøven som
er essensielt for beregninger av spenningkurve. Per i dag er det kun dimensjonene L0, E0
og H0 som benyttes i beregningene av spenning og tøyning. De resterende dimensjonene
er kun implementert for å kunne tilby de samme mulighetene for justering av dimensjoner
som hos det eldre systemet og gir fleksibilitet for potensiell videreutvikling.

Figur 3.13: Geometri dialog

For plotting av data benyttes to grafer. Øverste graf plotter kraften fra lastcellen og posi-
sjonen fra LVDT langs to akser. Den nederste plotter spenning-tøyningskurven («stress-
strain curve») og er den som oftest er av interesse ved material strekktesting. For å starte
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plottingen av måleverdier må data logging være aktivert. Dersom grafene ønskes nullstilt
benyttes reset datalog knappen. Da vil et ekstra dialog vindu dukke opp på skjermen for
å forsikre seg om at brukeren ønsker å slette måleverdiene. Vinduet illustreres i figur 3.14.

Figur 3.14: Advarselsdialog

For lagring av verdier ved datalogging er det mulig å åpne måleverdiene i separat excel-
dokument. Dette gjøres ved å trykke "File → Export" og lagre som CSV-fil, deretter
kan brukeren åpne filen i excel. Formatet for lagring av data er basert på ISO-6892
(A.2.1)[2] som gir et standard oppsett for lagring av måleverdier. Dette er en gunstig
funksjonalitet om man ønsker å beholde tallverdiene fra en strekktest over lengre tid
eller om man ønsker å hente ut måleverdier til videre forbruk eller analyse. I tillegg
til eksportering av numerisk datalogg vil det også være lagringsmuligheter for bilder av
grafene ved å høyreklikke innenfor grafens ramme. Under samme meny vil det også være
flere innstillinger for grafen.

Under Strength range vil man kunne velge strekkbordets maksimale kraft konfigurasjon.
Dette området bestemmes ut fra plasseringene til justeringspinnene som man kan se fra
figur 3.8(b). Konfigurasjon S1, S2 og S3 i brukergrensesnittet skal med andre ord samsvare
med de fysiske justeringspinnene på strekkbordet.

Det er implementert mulighet for justering av maksimal tillatt kraft («Max force»),
slik som på det eldre grensesnittet. Funksjonaliteten vil stanse motoren dersom kraften
overgår satt grense og vil være deaktivert dersom den er satt til null. Det samme gjelder
«Length range» i både «tensile» og «release» konfigurasjon ved at terskelverdien tar
hensyn til absoluttverdien av posisjonens relative nullpunkt. Dette gjør at brukeren kan
innstille til ønskede verdier uten behov for manuell justering.

Ved oppstart vil programmet automatisk forsøke å velge kommunikasjonsport for mikro-
kontrolleren. Det vil også være mulighet å manuelt velge kommunikasjonsport basert på
tilgjengelige enheter. Dette gjøres under "Tools → Port". Det ble implementert sikkerhets-
mekanismer som blant annet at motoren skrus av hvis systemet mister kommunikasjonen
til mikrokontrolleren. Det samme er gjeldene dersom brukergrensesnittprogrammet luk-
kes. Dette er viktig for at brukeren skal ha fullstendig kontroll over systemet til en hver
tid.
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3.5.2 Databehandling

Mottak av data fra mikrokontroller håndteres i en separat tråd, slik at databehandlingen
ikke påvirker responsiviteten i brukergrensesnittet. Rådataene fra ADC’en regnes om til
kraft og posisjon gjennom polynomer med koeffisienter som leses inn fra filen config.txt
som er vedlagt programmet (se 3.4). Tøying og spenning regnes ut ifra de justerbare
geometridataene. De beregnede dataene legges i en liste sammen med et tidsstempel, som
kan eksporteses i CSV format som beskrevet i ISO standarden for strekkprøving [2].

3.6 Beregninger av strekkfragment

Delen av strekkprøven som ønskes målt blir på engelsk kalt «gauge». «Gauge» ligger på
den smaleste delen av prøven, som har høyde og bredde H0 og E0, da det er den som
blir mest utsatt for spenning og tøyning. Da spenningen i «gauge» er jevnt fordelt over
tverrsnittet, kan spenningen beregnes ved å bruke formlene for «engineering stress» (1)
eller sann spenning (2) etter hva som ønskes. Tøyningen over hele prøven er større enn
tøyningen i «gauge», dermed vil formlene for spenning som er gitt i (1) og (2) ha med en
feilmargin bestående av forlengelsen utenfor «gauge».

I Solidworks ble det simulert hvordan tøyning er fordelt i materialet under strekk. So-
lidworks benytter en metode som kalles elementmetoden for å analysere figuren. Denne
metoden deler et objekt inn i mange små elementer og beregner hvordan spenning og
tøyning fordeles over disse. Oppløsningen av resultatet blir da tilsvarende størrelsen av
elementene, som gjør at det er begrenset hvor nøyaktig tøyningen vises. Figur 3.15 viser
hvor stor tøyningen i strekkretningen er. I denne simuleringen ble det brukt en modell for
karbonstål, og kraft som var lav nok for at ingen områder nådde plastisk deformasjon.
Det observerbart at den klart største delen av tøyningen skjer i den midterste delen på
«gauge», men deler av prøvens tøyning vil foregå utenfor dette område. I denne analysen
(3.15) er modellen belastet med svak nok kraft for at alt enda deformeres elastisk. Når
områder i prøven begynner å deformeres plastisk så vil disse områdene ha mye større tøy-
ning enn områder av prøven som deformeres elastisk, som vist i figur 3.15. Siden prøven
kommer til brudd før det oppstår til plastisk deformasjon utenfor «gauge», vil andelen av
tøyningen som skjer utenfor minke drastisk når den midterste delen deformeres plastisk.

For å forsøke å minske påvirkningen av forlengelsen utenfor «gauge» ble det også utviklet
en funksjon som forsøker å beregne hvor mye av den totale forlengelsen som skjer i områ-
det hvor spenningen er målt. Funksjonen delte strekkprøven inn i tre områder. En bred
del med parallele kanter, en smal del med parallele kanter og overgangen mellom dem.
Funksjonen beregnet hvor stor del av forlengelsen hver del har om spenningen var jevnt
fordelt over tverrsnittet i hele L1. Funksjonen ville da ha subtrahert den beregnede forlen-
gelsen utenfor «gauge», som ble definert som området med høyde H0 (3.13), av den totale
forlengelsen. Det er bare under elastisk deformasjon at all deformasjon er lineær, dermed
ville det blitt helt feil å gå ut ifra at tøyningen uansett er proporsjonal med spenningen.
Funksjonen beregnet stigningstall av lagrede data på kraft og forlengelse, for å se når
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Figur 3.15: Elementmetoden i Solidworks

den sluttet å utvikle seg lineært. Når utviklingen ikke lenger er lineær og stigningstallet
minker, ville den ha generert en funksjon som er lineariseringen av det elastiske området
til spennings/tøynings-grafen. Denne lineariserte funksjonen ble benyttet til å beregne
hvor mye de elastisk deformerende områdene strekker videre, og subtrahert dette fra den
totale forlengelsen.

En betraktelig svakhet i funksjonen er at spenningen ikke er fordelt jevnt utover tverr-
snittet i store deler av strekkprøven. Dette gjør at funksjonen eliminerer en uviss andel av
forlengelsen utenfor «gauge» i målingene. Å finne den sanne fordelingen av tøyningen ble
vurdert som for komplekst og utfordrende da det endrer seg ettersom hvilket materiale
som blir brukt. Et mer nøyaktig alternativ for å få til dette hadde vært å implemen-
tere elementmetoden, men der hadde også materialegenskaper vært krevd for nøyaktige
simuleringer.

Beregningene i det gamle systemet som blir erstattet er også blitt undersøkt. Spenning/tøyning-
grafen fra det gamle programmet ble sammenlignet med grafer tegnet med samme data.
Med måledata eksportert fra samme måling ble grafer for sann spenning/tøyning og «en-
gineering stress/strain» tegnet. Disse har blitt sammenlignet med grafen som det gamle
programmet tegnet ut ifra samme måledata. Figur 3.16 viser til venstre et skjermbilde
av spenning/tøyning-grafen, og til høyre med samme rådata beregnet sann spenning og
«engineering strain». Det har blitt konkludert med at grafen tegnet av programmet er
tilnærmet lik grafene som er blitt tegnet med funksjoner for sann spenning og tøyning,
og at programmet da med høy sannsynlighet beregner sann spenning og tøyning.

Svakhetene med å forsøke å eliminere feilmarginen som dannes av strekking utenfor «gau-
ge» med simuleringer eller beregninger er at det kreves mer informasjon fra brukeren om
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Figur 3.16: Sann og engineering spenning

geometrien av strekkprøven. Å se på forlengelse utenfor «gauge» som neglisjerbar gjør at
bare geometrien av «gauge» er nødvendig. Utregninger for sann spenning og tøyning kan
også gjøres i etterkant med eksportert rådata. Oppdragsgiver ønsket at beregningene ser
på strekking utenfor «gauge» som neglisjerbar og går ut ifra at kun den smaleste delen
av materialprøven strekkes. Oppdragsgiver ønsket også at «engineering stress/strain» ble
beregnet, fremfor sann spenning og tøyning. Det er det som da også er blitt implementert
i koden. Beregningene tar da utgangspunkt i den samme rådataen som det gamle syste-
met, men bruker formler for «engineering stress/strain» fremfor sann spenning og tøyning
som det gamle brukte. Det er også tatt i brukt samme valg for «gauge» som det gamle
systemet, som tilsvarer L0 (se 3.13).
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4 Resultater

4.1 Sluttprodukt

4.1.1 Instrumentboks & styrekrets

(a) Original krets (b) Ny krets

(c) Ny & eldre instrumentboks (d) Innside

Figur 4.1: Instrumentboks
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4.1.2 Datamaskin-programvare

Programvare for strekkbenken kan lastes ned fra GitHub:

GitHub/NTNU-E2227/TensileTester/releases/tag/Release

Mer detaljert funksjonsbeskrivelse ligger i seksjon 3.5.1 om design & funksjonalitet.

Navn Funksjon
Start/Stopp Starter og stopper motoren
Tensile/Release Dreieretningen til motoren
Max force Maksimalt tillatt kraft. Motor slås av dersom kraften overgår

satt grense. Funksjonen vil være deaktivert når satt grensen er
satt til 0

Tensile-speed Justering av strekkhastighet
Length range Maksimal lengdeendring fra satt nullpunkt. Motor slåes av der-

som lengden overgår satt grense. Funksjonen vil være deaktivert
når grensen er satt til 0

Strength range Velger konfigurasjon for kraft måling. Må tilsvare fysisk konfigu-
rasjon på strekkbordet

Data logging Start/stopp logging av måleverdier
Reset datalog Nullstiller målepunktslogg
Direct data Avlesning av live verdier
Tools→Port Valg av COM port
Tools→Geometry Åpner geometri vindu for justering av materialprøve dimensjoner
Tools→Reset ADC Re initialisering av ADC
File→Export Eksporterer datalogg som CSV fil

Tabell 4.1: Funksjonsbeskrivelser for brukergrensesnitt

Programmet er utviklet med utgangspunkt i at det skal fungere på operativsystemet
Windows. Siden programmet som kjører på datamaskinen er skrevet i Python, skal det
kunne kjøres på en rekke andre operativsystem også. Brukergrensesnittet er blitt vellykket
brukt på Linux distribusjonen Manjaro, men da måtte kommandoen «sudo chmod 666
/dev/portnr. » kjøres i terminalen før programmet startes, for å gi tilgang til porten
som ble brukt. Om det skulle være problemer med å kjøre Python-programmet er det høy
sannsynlighet for at det er problemer med Python versjonen eller at kodens interaksjon
med I/O ikke fungerer av systemspesifikke grunner. Kildekoden fungerer kun på andre
system som støtter Python, imens det kompilerte programmet som kjøres som en .exe-fil
kjører kun i Windows.
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4.2 Nøyaktighet og presisjon

4.2.1 Sammenlikning med eksisterende utstyr

For å kvalitetssikre arbeidet er strekkprøving av tilsvarende materialprøver gjennomført
med nytt og gammelt system. Resultatene viser svært lik oppførsel i det linære området,
men store ulikheter i det ulineære området. Kurven for det nye systemet har også en
unaturlig brå knekk i overgangen fra linært til ulineært område, og prøven ryker ved til-
svarende kraft, men betydelig mindre forlengelse. Flere tester har gitt tilsvarende resultat.
Det ikke kjent hvorfor resultatet blir såpass ulikt, men det er verdt å merke at det under
arbeidet har blitt ført dårlig kontroll på materialprøvene og noen av prøvene har blitt
strukket flere ganger uten å gå til brudd, som kan føre til ulikt resultat. Noe av forskjellen
kan også skyldes ulikheter i strekkhastigheten (se 4.2.2).
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Figur 4.2: Sammenlikning av strekkprøving

4.2.2 Hastighetsregulering

Strekkhastigheten reguleres ved måling av omdreiningshastigheten på motorakslingen (se
3.4.3) som er koblet til strekkhodene gjennom et reduksjonsgir. Kalibreringen av strekk-
hastigheten er gjennomført uten belastning, altså uten strekkprøve montert. Når en ma-
terialprøve er montert belastes giret annerledes avhengig av materialprøvens egenskaper.
Figur 4.3 viser strekking av en metallprøve, hvor strekkhastigheten ligger langt under re-
feransen så lenge prøven er i elastisk område, og først oppnår referansehastigheten etter at
prøven har begynt å gi etter. Testing ved høyere referansehastighet viser at motoren er i
stand til å opprettholde strekkhastighet over 10µm/s under belastning. Direkte målinger
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fra motorkontrolleren viser konstant rotasjonshastighet på motorakslingen, som tyder på
at det er endringer i karakteristikken på overføringen fra motor til strekkhastighet un-
der belastning som fører til avviket. En interessant observasjon er at når materialprøven
ryker går posisjonen umiddelbart opp til hvor den hadde vært om den holdt referansehas-
tigheten under hele forløpet. Denne karakteristikken gjelder for både det nye- og gamle
systemet.
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Figur 4.3: Belastet strekkhastighet

Oppløsningen for regulering av strekkhastigheten er i teorien begrenset av avlesingen av
PWM signalet i motorkontrolleren, som er oppgitt i databladet [8] til å typisk ligge på
±0.1% ved 10 Hz. Siden signalet er begrenset til arbeidssyklus mellom 10-90% tilsvarer
det ca. ±0.11% av måleomfanget, og med hastigheter fra 0 − 6200rpm kan strekkhastig-
heten i teorien reguleres i steg på 6.82rpm.

4.2.3 Støy

Logging av måleverdier over en lengre periode uten at motoren er i drift (figur 4.4) viser
høyfrekvent støy med amplitude på ca. 0.1µm og 0.5N , og drift over tid på opp til 1µm
og 0.5N . Temperaturendringer er en mulig årsak til driften i måleverdiene. Når motoren
er i drift er det sannsynlig at støyen øker i amplitude. Det er ikke kjent om montering i
SEM påvirker støyen. En observert kilde til støy er at tidsstempelet som assosieres med
måledataene kan være forsinket hvis det bygger seg opp kø i databehandlingen, som kan
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Figur 4.4: Statiske støymålinger

føre til at flere målepunkter behandles på samme tid og får samme tidsstempel. Dette
påvirker ikke kraft/forlengelse og spenning/tøying beregningene, og kommer kun frem i
eksporterte data.
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5 Diskusjon

5.1 Prosjektplan og gjennomføring

5.1.1 Prosjektleveranser

I forprosjektet ble det beskrevet en forventet leveranse ved prosjektslutt av styreenhet,
PC programvare til styreenhet og dokumentasjon til bruk, vedlikehold og videreutvikling.
Styreenhet og programvare leveres med grunnlegende funksjonalitet som benyttes for ut-
føring av strekkprøving. Dokumentasjonen som allerede var tilgjengelig var begrenset og
utdatert som påvirket tidsbruken for utvikling. Det har derfor vært en høyt prioritert
del av oppgaven å dokumentere for å kunne forenkle både for nåværende- og fremtidig
utvikling av utstyret.

5.1.2 Tidsforbruk
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Figur 5.1: S-diagram
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Figur 5.2: Tidsforbruk per person

5.1.3 Budsjett

I forprosjektet for oppgaven ble det anslått et nødvendig budsjett på 5500,- NOK før
MVA. Totalsummen for alle innkjøpte komponenter som ble brukt i prosjektet (vedlegg
D) havnet på 5618.11,- NOK. før MVA. I tillegg til de innkjøpte komponentene er det
brukt en del passive komponenter (motstander og kondensatorer), og metallplater og
skruer/muttere som har vært tilgjengelig gjennom NTNU.

5.2 Fremtidig utvikling

• Dersom strekkbordet ikke er jordet oppstår det målefeil i kraftmålingen når moto-
ren startes ettersom at potensialet i strekkbenken endres av motorens magnetfelt.
Strekkbordet tilkobles jord ved å ha kontakt med den metalliske skjermen på mik-
ro D-sub som vist i figur 5.3. Per idag blir ikke skjermen jordet, men kan relativt
enkelt fikses. Metallskjermingen rundt kablene frem til kontakten er jordet, og må
videreføres til skjermen på kontakten som er i kontakt med strekkbordet. Ettersom
strekkbordet kun har kontakt med jord gjennom den metalliske overflaten av kon-
takten, vil en av de tilhørende kablene ikke fungere tilstekkelig og burde derfor ikke
benyttes. Dette kommer av at kabelen benytter en plastikk skjerming rundt mikro
D-sub, noe som gjør at strekkbenken ikke oppnår kontakt med jord.
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(a) Micro d-sub i plastikk og metall (b) Jordkontaktspunkt

Figur 5.3: Jording av strekkbord

• Den viktigste utviklingen som anbefales er en standardisert metode for kalibrering
hvor en kjent kraft kan påtrykkes lastcellen tilsvarende hvordan kraften blir påtrykt
under strekking. Et forslag til hvordan dette kan gjennomføres er å anskaffe en
gjengestang med samme gjengestørrelse som skruen lastcellen er montert på, og
montere lastcellen mot en plate slik at en kjent kraft kan påtrykkes gjengestangen
slik som vist i figur 5.4.

Lastcelle Fastmontert plate

Gjengestang

F

Figur 5.4: Forslag til lastcelle kalibrering

• Det anbefales også å utvikle en regulator for strekkhastighet med tilbakekobling fra
posisjonsgiveren (LVDT) slik at strekkhastigheten kan holdes konstant både under
elastisk og plastisk deformasjon. Det enkleste vil være å implementere denne i PC
programvaren.

Motorkontroller Motor Gir

Tachometer

Settpunkt Strekkhastighet

Posisjonsgiver

Regulator

Figur 5.5: Forslag til hastighetsregulering
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• Det er også etterspurt funksjonalitet for å spenne opp materialprøven til en kjent
kraft for å utelukke ulineariteter tidlig i deformeringen.

• Både under dette prosjektet og tidligere har det vært et problem at kablene på
strekkbordet er svært skjøre og har gjentatte ganger blitt loddet. Det vil være til
fordel for fremtidig bruk om disse byttes ut med mer solide kabler.

• For å gi en indikering på systemets tilstand vil det være fornuftig å vurdere lysindi-
kering direkte fra instrumentboksen. Dette kan gjøres ved å koble et lys i parallell
med forsyningsbanen til 30V og blir da en indikering på om systemet er tilført spen-
ning eller ikke. Dersom indikeringen ikke aktiveres kan dette også tyde på at en av
sikringene er ødelagt eller at det er oppstått andre elektriske feil. Plasseringen av lys
gjøres ideelt sett på boksens framside, men kan også plasseres andre iøynefallende
steder som er lett synlig for brukeren.

• Det kan også vurderes å flytte tidsstemplingen av dataene til mikrokontrolleren for
å unngå at flere målepunkter får samme tidsstempel.

• Det burde foretas en risikovurdering for oppkoblingen av 230V AC-strømforsyningen
på innsiden av instrumentboksen.
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6 Konklusjon

Gjennom prosjektet er det utviklet elektronikk og programvare som svarer til målene som
ble satt i forprosjektet, og innehar den grunnleggende funksjonaliteten som er nødvendig
for strekkprøving. Et overordnet mål for prosjektet var å konstruere et system som har
de samme grunnleggende funksjonaliteten som tidligere, men med bruk av mer moderne
teknologi. Noe det nye systemet tilfredsstiller i stor grad gjennom både komponentvalg
og programvareløsning. I prosjektet er det i tillegg foreslått muligheteter for fremtidi-
ge forbedringer som vil kunne gjøre systemet enda mer nøyaktig eller gi systemet flere
gunstige funksjonaliteter. Flere av disse vil være mulig å implementere uten alt for store
innretninger eller kostnader.

Dokumentet gir en grundig beskrivelse for hvordan systemet fungerer, samt generell ut-
vikling av systemet og begrunnelser for de avgjørelsene som er gjort. Sammen med do-
kumentet er flere essensielle vedlegg lagt ved, men også programfiler som er essensielt for
bruk av systemet. Programfiler ligger også tilgjengelig på GitHub og kan nedlastes som
et kjørbart program.
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(a) Male pinout (b) Female pinout

Pin No. Farge Funksjon Komponent Tilkobling
1 → Blå Sekundær (1) LVDT AIN-
2 → Rød Primær (1) LVDT EXC1
3 →
4 → Grønn Signal (-) Lastcelle Vin-
5 → Rød Forsyning (-) Lastcelle GND
6 →
7 → Hvit Forsyning (+) Motor M+
8 → Rød Signal (+) Tachometer Ain1+
9 → Grønn Sekundær (2) LVDT AIN+

10 → Gul Primær (2) LVDT EXC2
11 →
12 → Hvit Signal (+) Lastcelle Vin+
13 → Svart Forsyning (+) Lastcelle 10V
14 → Blå Forsyning (-) Motor M-
15 → Gul Signal (-) Tachometer Ain1-



Vedlegg C Utregning av komponenter
LVDT



Beregninger ut fra datablad [3]:

For fastsetting av frekvensen til eksitasjonsspenningen ble kondensatoren beregnet med
utgangspunkt i steg 4. Målinger med oscilloskop verifiserer frekvensen på ≈ 5kHz.

C9 = 35µF

5kHz
= 7nF ≈ 6.8nF

Motstandsverdier for fastsetting av amplitude for eksitasjonsspenningen ble valgt fra steg
6. Målinger med oscilloskop ga i utgangspunktet avvik på amplituden. Dette ble innjustert
manuelt ved å øke til høyere motstandsverdi.

R7 + R9 = 7.8kΩ

Fastsetting av kondensatorer for filtrering av målesignal tar utgangspunkt i steg 7.

fsubsystem = fexc

10

C11 = C12 = C13 = 10−4FHz

fsubsystem

= 10−4FHz
5kHz

10
= 0.2µF

For en total spenningsendring på en volt på fysiske måleområdet ble motstandsverdien
på 10kPot satt til:

10kPot = 3.41kΩ

Komponenter for signalreferanse må oppfylle to krav beskrevet i steg 10 og steg 11:

R2 og R3 ble satt til 100kΩ for å kunne oppfylle begge krav.



Vedlegg D Komponentliste



Komponentliste bachelorprosjekt E2227
*Alle priser er ekskludert MVA og frakt.

Fabrikant Navn Leverandør nr. Antall Pris (total)*
DJ Stork Drives AS

Maxon Motors ESCON 36/2 DC *Bestilles via epost 1 1743.00,- NOK
Mouser Electronics

Analog Devices AD698SQ 584-AD698SQ 1 1196.90,- NOK
Analog Devices AD7714ANZ-5 584-AD7714ANZ-5 1 262.00,- NOK
HARTING Dsub 15p male 617-09662226802 1 55.00,- NOK
Nisshinbo 5V 1A VRM 513-NJM2388F05 1 11.30,- NOK
Microchip Atmega4809 579-DM320115 1 183.60,- NOK
CTS SP024S 774-MP024S 1 11.40,- NOK
Phoenix Contact Terminal Blocks 8P 651-1725711 1 63.4,- NOK
Phoenix Contact Terminal Blocks 2P 651-1985962 1 15.7,- NOK
Samtec Socket Strip 200-SSA128SG 2 132.8,- NOK
Panasonic Film Capacitor 0.2uF 667-ECW-F4204JL 4 61.2,- NOK
Panasonic Electrolytic Capacitor 22uF 667-ECA-1VM220I 4 9.48,- NOK
WIMA Film Capacitor 6.8uF 505-MKS2B046801M00JS 1 29.6,- NOK

RS Components
Maxon Motors Power cable 756-9745 1 87.15,- NOK
Maxon Motors Digital I/O cable 756-9733 1 111.04,- NOK
Maxon Motors Analogue I/O cable 756-9736 1 118.40,- NOK
Maxon Motors Motor cable 756-9739 1 109.77,- NOK
New Japan Radio 10V 1A VRM 713-9868 5 83.49,- NOK
RS PRO Instrument Case 754-5963 1 353.9,- NOK
RS PRO C14 Snap-In IEC 811-7229 1 36.76,- NOK
RS PRO M3 Button Screw 822-9155 1 139.26,- NOK
XP Power 30 VDC 40W PSU 122-7107 1 427.14,- NOK
Bourns 10kΩ Potentiometer 521-9192 2 91.54,- NOK
Bourns 1kΩ Potentiometer 521-9186 1 45.77,- NOK
Wurth M3 Hex standoff steel 176-8426 10 31.42,- NOK
Wurth M3 Hex standoff polyamid 184-1912 10 107.8,- NOK

JLC-PCB
JLC PCB Kretskort NIL 5 99.89,- NOK

Sum: 5618.11,- NOK

https://no.mouser.com/ProductDetail/Analog-Devices/AD698SQ?qs=NmRFExCfTkFDkagQGAycvg%3D%3D
https://no.mouser.com/ProductDetail/Analog-Devices/AD7714ANZ-5?qs=%2FtpEQrCGXCxdrtPIlJA5Lg%3D%3D
https://no.mouser.com/ProductDetail/HARTING/09662226802?qs=vMzbrHvTwPHOT4CDpuHWhA%3D%3D
https://no.mouser.com/ProductDetail/Nisshinbo/NJM2388F05?qs=sGAEpiMZZMvxX9Q80wbhCbzLFErNSiR9
https://no.mouser.com/ProductDetail/Microchip-Technology/DM320115?qs=sGAEpiMZZMv0NwlthflBi4UzTHrj%252BUATF6y%2F8caWHDU%3D
https://no.mouser.com/ProductDetail/CTS-Electronic-Components/MP024S?qs=sGAEpiMZZMsBj6bBr9Q9abEqPcVkAuY%2FW4iRXfcWFRI%3D
https://no.mouser.com/ProductDetail/Phoenix-Contact/1725711?qs=W3wJikR1%252BS7n1cN8b%252BRI%2FQ%3D%3D
https://no.mouser.com/ProductDetail/Phoenix-Contact/1985962?qs=UV0HhPl4yOHh6Jd%252BVuiYEg%3D%3D
https://no.mouser.com/ProductDetail/Samtec/SSA-128-S-G?qs=rU5fayqh%252BE1iMuB5YM4UIg%3D%3D
https://no.mouser.com/ProductDetail/Panasonic/ECW-F4204JL?qs=sGAEpiMZZMsh%252B1woXyUXj8sFZ9IYHELTqQVM3%252BohULg%3D
https://no.mouser.com/ProductDetail/Panasonic/ECA-1VM220I?qs=sGAEpiMZZMsh%252B1woXyUXjwZRX3FJcpeVOdd0YWPCph8%3D
https://no.mouser.com/ProductDetail/WIMA/MKS2B046801M00JSSD?qs=sJjjjplDs9tKfWQHWx8S3g%3D%3D
https://no.rs-online.com/web/p/motor-accessories/7569745
https://no.rs-online.com/web/p/motor-accessories/7569733
https://no.rs-online.com/web/p/motor-accessories/7569736
https://no.rs-online.com/web/p/motor-accessories/7569739
https://no.rs-online.com/web/p/voltage-regulators/7139868
https://no.rs-online.com/web/p/instrument-cases/7545963
https://no.rs-online.com/web/p/iec-connectors/8117229
https://no.rs-online.com/web/p/socket-screws/8229155
https://no.rs-online.com/web/p/embedded-switch-mode-power-supplies-smps/1227107
https://no.rs-online.com/web/p/trimmer-potentiometers/5219192
https://no.rs-online.com/web/p/trimmer-potentiometers/5219186
https://no.rs-online.com/web/p/standoffs/1768426
https://no.rs-online.com/web/p/standoffs/1841912
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